
About AntiVir Guard
The AntiVir PersonalEdition Classic with the on-access scanner AntiVir Guard has been developed 
especially for home users. It is completely free of charge for private use and can be obtained from the 
following Internet URL: http://www.free-av.com.

AntiVir ProfessionalEdition
If you need support of network drives or if you need any more functionality, we recommend the 
enhanced version of AntiVir: AntiVir 6 ProfessionalEdition. 

Currently there are the following AntiVir products available:

AntiVir for DOS, AntiVir for Windows Workstation, AntiVir for OS/2, AntiVir for Linux Workstation, 
AntiVir for Novell NetWare, AntiVir for Windows Server, AntiVir for Linux Server, AntiVir for FreeBSD, 
AntiVir for OpenBSD, AntiVir for Exchange Workstation, AntiVir for Exchange Server, MailGate for 
Linux, MailGate for FreeBSD, MailGate for OpenBSD, Milter for Sendmail, WebGate, AVM KEN!, F-
1, SAVAPI.

More information about these products is available from one of the address below or from the 
Internet:

H+BEDV Datentechnik GmbH Internet: http://www.hbedv.com
Lindauer Strasse 21 Email: info@hbedv.com
88069 Tettnang Phone: +49 (0) 7542 - 500 0
Germany Fax +49 (0) 7542 - 525 10

About AntiVir Guard
This dialog box displays some information concerning the AntiVir Guard control program.

Version information
This info box displays version information concerning the AntiVir Guard.

Hotline
Technical support is available via Internet only.

Technical inquiries via Phone/Fax/Letter and e-mail can not be answered!

In order to facilitate your inquiries to the technical support, we have created an Internet Support 
Forum for you.

You find the AntiVir Support Forum on the internet at: http://www.free-av.de/forum.

You will find the frequently asked questions about AntiVir PersonalEdition Classic and you will have 
the possibility to submit technical questions to all other forum members and our moderators. 
Additionally, you can discuss with other users of AntiVir and share your own experiences and hints.

Additional product information
This section contains the information how to contact us if you need any other information or 
assistance concerning our AntiVir ProfessionalEdition products.

Suspicous files



Unknown new Malware so as suspicious files can be sent as an encrypted archive (ZIP, RAR etc.) in
the attachment of an email to the following addresses:

virus@free-av.com
dialer@free-av.com
heuristic@free-av.com

Please don't forget thereby to send the password for the archive and a small description of the file or
of the appeared phenomena.



AntiVir ProfessionalEdition
Besides the AntiVir PersonalEdition Classic, H+BEDV Datentechnik GmbH offers the AntiVir 
ProfessionalEdition. This package provides a very enhanced functionality and a flexible and cheap 
licensing, especially in multi-user environments.

Additional Features:
Support of network drives.
Support of network messages and warnings.
Support of search profiles.
Scanning of single and multiple directories.
Scanning of user-defines archives.
Explicit scanning of boot records.
Intranet-Update-Wizard. This is a tool to automatically distribute the software and updates in your 

network.
Start of external programs depending on the search results.
Scheduler.
Password protection for the configuration.
CRC option.
Enhances configuration possibilities for the scan- and repair engine.
The email scanner for MS Mail, Qualcomm Eudora, MS Outlook and MS Exchange Client are 

included. 

Currently there are the following AntiVir products available:

AntiVir for DOS, AntiVir for Windows Workstation, AntiVir for OS/2, AntiVir for Linux Workstation, 
AntiVir for Novell NetWare, AntiVir for Windows Server, AntiVir for Linux Server, AntiVir for FreeBSD, 
AntiVir for OpenBSD, AntiVir for Exchange Workstation, AntiVir for Exchange Server, MailGate for 
Linux, MailGate for FreeBSD, MailGate for OpenBSD, Milter for Sendmail, WebGate, AVM KEN!, F-
1, SAVAPI.

Information about the AntiVir Professional products is available at:
H+BEDV Datentechnik GmbH Internet: http://www.hbedv.com
Lindauer Strasse 21 Email: info@hbedv.com
88069 Tettnang Phone: +49 (0) 7542 - 500 0
Germany Fax: +49 (0) 7542 - 525 10



Close Control Program
To completely exit and close the Control Program you have to click this item. The program will be 
completely closed. A restart is only possible using the icon in the AntiVir program folder.



Configuration

This menu displays a property sheet to configure the AntiVir Guard Service. The button  has the 
same effect.

The property sheet contains the following tabs:

Scanner All settings used by the device and the scanner itself.
Action Actions to take when a virus or unwanted program has been found.
Repair Repair settings.
Heuristic Settings for the AntiVir virus heuristic.
Logfile Logfile settings.
Filters These options can be used to configure excepted objects for the on-access 

scan.
Unwanted Programs AntiVir reports viruses and other malware in any case. In addition AntiVir will 

report all marked types of unwanted programs.



Contents
These help pages are currently available:

About AntiVir Guard
AntiVir ProfessionalEdition
Close Control Program
Configuration
Demo Version
File Action
File Extensions
Main Window
Minimize Control Program
New File Extension
Property Tab Action
Property Tab Filters
Property Tab Heuristic
Property Tab Logfile
Property Tab Repair
Property Tab Scanner
Property Tab Unwanted Programs
Service-Status
The File Menu
The Help Menu
The Options Menu
Trouble Shooting
Unwanted Programs
Virus Infection
Windows Security Center



Demo Version
Demo-Version

If you don't have a valid license key file, AntiVir Guard PersonalEdition Classic will run in the 
restricted demo mode. This means that it will only scan files on the volume C: of your computer.



File Action
In this box, you will see the currently selected action to be performed by AntiVir Guard in 
case of a detection.

Repair file
AntiVir Guard attempts to repair an concerning file. If the repair attempt fails, the action selected 
under Action if File not Repaired is performed.

Please note that the following actions will only be performed if the reported file is unable to be 
repaired.

Delete file
The concerning file will be deleted. It can be restored using some special tools. The signature of this 
virus or unwanted program can be found on your volume in the future.

Wipe file
The concerning file will be overwritten with a default pattern and deleted afterwards. It cannot be 
restored anymore. 

Move file
The concerning file will be moved to the quarantine directory set in the filed Quarantine Directory. If a
file with the same name already exists, the file to move will be renamed to *.001, *.002, etc. The files
in this directory can be repaired later on or you can send us such files for further investigations if 
needed.

Rename file
The concerning file will be renamed to *.001, *002, etc. Any direct shell shortcut to the file will be 
disabled. You can re-rename and repair the file later on.

Deny access
The detection will only be reported to the logfile and to the event log if enabled.



File Extensions
The file extensions used by AntiVir Guard when Use file extension list is enabled are stored in this list.

You can edit the list as follows:

{button OK,}

This closes and saves the current list.

{button Cancel,}

The changes made are cancelled.

{button Insert,JI(`',`HELP_EDIT_EXTENSION')}

Opens a window to edit and insert a new file extension.

{button Delete,}

This deletes the currently marked item in the list.

{button Default,}

This sets the list to the default file extensions as shipped by H+BEDV Datentechnik GmbH.

{button Help,}

Displays this help screen.



Main Window
The main window of AntiVir Guard for Windows consists of 3 main areas: the menu bar, the tool bar and 
the display area. Additional configuration options are available with our professional version, AntiVir 
ProfessionalEdition.

The menu bar options
File
Options
Help

Display group "AntiVir Guard"
Service-Status This shows the current status of the AntiVir Service (Active, Not Active, Not 

Loaded).
Notify User Indicates whether the user is to be notified or the selected action performed 

automatically. (In the AntiVir Personal Edition the default setting is "Yes".)
File Action This field displays the action taken if an reported file has been found and the user 

notification has been disabled.
File To Scan All files or only files with a specific file extension.
File Count The number of files scanned.
Last Detection The name of the last virus or unwanted program found.
Detections The number of viruses and unwanted programs found.

Display group "Last scanned file"
This field displays the last file scanned by AntiVir Guard.



Minimize Control Program

or use the button  

Click this item if you would like to exit the Control Program but don't want to close it. It will be minimized 
and you can see its icon placed in the system tray. A double click on the small icon in the system tray will 
enlarge it for further use. When minimized, the AntiVir Guard Control Program does not consume any 
CPU cycles. 



New File Extension
You can enter a new file extension in this dialog box. The maximum length of a new extension is 6 
characters. 

{button OK,}

The current extension will be inserted into the list of file extensions.

{button Cancel,}

The current extension will be thrown away and not inserted into the file extension list.

{button Help,}

Displays this help screen.



Property Tab Action
This sheet configures how AntiVir Guard shall react when a virus or unwanted program has been 
detected.

Action if file not repaired
When AntiVir Guard discovers a virus or unwanted program it will display a dialog box to let the user 
select the action to be taken. If the file could be repaired and the repair mode is enabled, the user can 
select to repair the file. If this repair fails, the action selected in this group box will be taken. If the user 
selects another option in the displayed dialog box, the selected action will be taken.

Move to quarantine directory
The concerning file will be moved to the Quarantine Directory entered in the appropriate field. Note 
that only the Administrator should have access rights to this directory!

Delete concerning file
The concerning file will be deleted but can be restored using appropriate tools.

Wipe concerning file
The concerning file will be overwritten and deleted and cannot be restored anymore.

Rename concerning file
The concerning file will be renamed to *.001, *.002, ... It can no longer be accessed using the shell.

Deny access to file
The detection will only be reported to the logfile if enabled.

Notifications

Use event log
If enabled, any detection will be reported to the event log. The administrator now can check your 
workstation if there have been any viruses and unwanted programs detected.

Play a sound
If selected, AntiVir Guard will play a short jingle when an concerning file has been found. This is the 
default AntiVir jingle.

Quarantine directory
If a file is to be moved to the quarantine directory, AntiVir Guard will move it to the directory specified
in this field.

Drives to monitor
AntiVir Guard can be configured to monitor only a specific set of drives on your computer.

Local drives
Only files located on local drives (e.g. Floppy Disks, Hard disks, CD-ROMs, ZIP-Drives, MO-Drives, 
etc.) will be scanned.



Property Tab Filters
These options can be used to configure excepted objects for the on-access scan. The objects concerned 
will then be disregarded by the on-access scanner. Using the list of processes to be omitted, AntiVir can 
ignore their file accesses during the on-access scan. This is useful in the case of databases or backup 
solutions, for example.

Processes to exclude form real time scanning
All file accesses by processes in this list are ignored. To add a new process to this list, enter the 
name of the process in the box on the left and click on {button Add >>,}. The easiest way to find the 
name of the relevant process is via the task manager. You will find the names of all currently active 
processes on the "Processes" page. Look for "your" process and enter its name (to find under 
"Image Name"). You can delete the currently highlighted entry from the list with {button <<    Delete,}.

WARNING:

Please note that all file accesses by processes included in the list are excluded from the scan
for viruses and unwanted programs! The Windows Explorer and the operating system itself 
cannot be excluded from virus scanning. An appropriate entry in the list will be ignored.



Property Tab Heuristic
This property tab contains the settings the heuristic of the AntiVir search engine.

AntiVir contains very powerful heuristics that can also detect unknown (new) viruses, worms or Trojans. 
This is done by intensive analysis and scanning of the corresponding code for functions that are typical 
for viruses, worms or Trojans. If the scanned code has these characteristic features, it is reported as 
suspicious. However, this does not necessarily mean that the code is actually a virus, a worm or a Trojan; 
false alerts may also occur. The user has to decide what to do with the relevant code, e.g. based on his 
knowledge of whether the source containing the code is trustworthy.

Macro virus heuristic
AntiVir contains a very powerful macro virus heuristic. In the event of a possible repair, all macros are 
deleted, or alternatively suspicious documents are only reported, i.e. you receive an alert.

Win32 file heuristic
AntiVir contains a very powerful heuristic for Windows file viruses, worms or Trojans that can also detect 
unknown viruses, worms or Trojans. If it is enabled, you can set how "aggressive" this heuristic should be.

Detection level low
With this setting AntiVir detects slightly fewer viruses, worms or Trojans, the risk of possible false 
detections is low.

Detection level medium
This is the default setting if you have selected to use this heuristic.

Detection level high
In this setting AntiVir detects very many unknown viruses, worms or Trojans, but you must also 
expect false reports.



Property Tab Logfile
AntiVir Guard has a very powerful log function included. It is able to give the administrator a complete 
report of what's going on with your machine. You can choose what AntiVir Guard shall include into the 
logfile.

Name and path of logfile
This is the name and the path of the logfile to write. Each entry will be added to this file.

Logging level
This group defines what to include into to logfile.

Disable reporting
Reporting will be disabled completely. This option is only useful for tests with lots of viruses and 
unwanted programs when a maximum performance is required.

Standard information
All important information like detections, warnings, errors etc. will be included in the logfile. Minor 
important things will be ignored to give you a fast and easy overview onto the current status.

Extended information
Even minor important things like additional information will be included in the logfile.

Complete information
File size, types and dates as well as the rest of all possible information will be included.

Limit size of logfile

Limit size of logfile to n Kilobytes
AntiVir Guard can limit the size of the logfile for the on-demand scan automatically. A margin of 
approx. 50 kilobytes is allowed in order to minimize the CPU utilization. If the logfile exceeds the 
specified size by 50 kilobytes, old entries are automatically deleted until the specified size minus 50 
kilobytes is reached.



Property Tab Repair
This sheet includes the repair properties.

Reported files

Activate repair
If selected, AntiVir Guard will try to repair reported files.

NOTE: This option has to be activated too, if you would like to have the repair option enabled that is 
shown in the dialog box displayed when an reported file has been detected.

Backup
AntiVir Guard can create a backup copy of the concerning files prior repair. This function is appropriate in several 
cases. It is appropriate for documentation reasons on the one hand; if a virus or unwanted program is documented 
and logged. On the other hand, it is appropriate if a macro virus has been recognized and is removed from the 
heuristic with enabled repair. Please send us the created backup copy in the latter case, in order that the signature 
can be included in the next AntiVir update.

Create backup before repair
If this is enabled, AntiVir Guard will copy the reported file (create a backup) to the directory specified 
in the field below. This can be useful for documentation reasons and - if the heuristic macro virus 
scanner has detected and removed a suspicious macro inside a document - to save the reported 
original to be able to send it to us. We will then include a scan string for this detection into the 
product to be able to remove it after the next software update.

Backup directory
This is the directory where to create the backups.



Property Tab Scanner
These settings are used to configure the scanner of AntiVir Guard.

Device mode
This group specifies the time when to scan an accessed file. This can be configured to optimize AntiVir 
Guard for you specific needs. For maximum security needs you should have both options enabled (Scan 
on file read and write).

Scan on file read
If selected, all files will be scanned before they have been read or executed by the application or the 
operating system. This means that a file will be scanned for viruses and unwanted programs before 
you'll get access to it. This is a good choice since AntiVir Guard includes a filename cache which will 
cause a file only be scanned once.

Scan on file write
If this option is selected, all files will be scanned after they have been written to the volume. This 
means that a file just saved to a volume will be scanned for viruses and unwanted programs before 
anyone will get access to it. This is a good option for Internet downloads.

Scan on file read and write
Files will be scanned for viruses and unwanted programs before they have been open or executed 
and after they have been written to a volume (see above). Please note that this option may decrease
system performance because files may be scanned more than once.

Files to scan
AntiVir Guard can be configured to use a filter to exclude some files that are normally not hosts for viruses
and/or unwanted programs. This can improve the system performance depending on you environment.

All files
If selected, all files accessed in the specified device mode will be scanned automatically.

Enhanced file system support

These options will activate data systems-specified expansions in AntiVir Guard.

When this option is activated, every acess to data or record is being scanned by AntiVir Guard 
whether ther are additional data streams (Alternate Data Streams) included.

If yes, those streams will be tested additionally ontop of the normal data tests, for viruses and 
unwanted programs.

Warning:
These options can reduce the performance of your system considerably.

Notice:
Even without this activation option your system will be protected with AntiVir Guard, if there is an 
explicit access to the Alternate Data Streams.

Use file extension list
Only files with a file extension that matches an extension in the file extension list will be scanned.



{button Extensions,JI(`',`HELP_FILE_EXTENSIONS')}             
Opens a window with a list of file extensions used by the scanner.

Archives
AntiVir Guard is able to decompress archives and to scan the included files afterwards. Note that this can 
cause an impressive loose of performance.

Unpack runtime compressed files
Files compressed with runtime packers are first scanned, then unpacked and scanned again. That 
way viruses/unwanted programs hidden in the compressed files can also be found.

Drives to monitor
AntiVir Guard can be configured to monitor only a specific set of drives on your computer. In the Home 
edition, these are only the local drives. Support of network drives is included in the professional version: 
AntiVir ProfessionalEdition.

Local drives
Only files located on local drives (e.g. Floppy Disks, Hard disks, CD-ROMs, ZIP-Drives, MO-Drives) 
will be scanned.



Property Tab Unwanted Programs
AntiVir protects you against computer viruses.

In addition, it will also scan selectively for dialer, Backdoor Clients, games, jokes, Security Privacy Risk 
Software, Unusual Runtime Compression Tools, Double Extension Files.

Security Privacy Risk (SPR)
Jokes (JOKES)
Games (GAMES)
Dialer (DIALER)
Backdoor Client (BDC)
Unusual Runtime Compression Tools (PCK)
Double Extension Files (HEUR-DBLEXT)

The selection is activated by clicking on the relevant box.

To activate all types, click on Select all.

The button {button Set to Defaults,} re-establishes the default values suggested by AntiVir.

If a type is deactivated, files which are identified as being of that program type will no longer be reported 
entered in the report file.



Service-Status
This field displays the current status of the AntiVir Service. 

Active
This means that the service is loaded and active. Communication between the control program and 
service is now possible. The service operates according to the chosen settings. 

Note: Even when AntiVir Guard is activated, this doesn't necessarily mean that AntiVir will scan for 
viruses or unwanted programs, as the device driver, drives to be monitored or other equipment may 
be deactivated.

Not Active
This means that the service is loaded but not active. In other words, it is not scanning for viruses or 
unwanted programs. All files can pass freely through the system, i.e. you are not protected against 
viruses and unwanted programs!

Not Loaded
The control program of AntiVir Guard was unable to find an active AntiVir Service on the computer, 
or communication is not possible. This means that all files can pass through the system unchecked, 
i.e. you are unprotected against viruses and unwanted programs. 

This message can also point to a problem, however, e.g. the service may not be loaded or it may 
have been terminated manually. Alternatively, the monitoring program and service may be 
incompatible (different versions) or there may be a communication problem. In this case, check the 
event log on the target computer.



File Menu
This menu contains the following entries:

Activate AntiVir Guard

This menu option activates and deactivates AntiVir Guard. After initial installation, AntiVir Guard 
should always be ready activated. You can use this menu option to activate AntiVir Guard (tick 
visible) or temporarily deactivate it (tick invisible).

Start AntiVir Main Program

This will start the AntiVir Main Program directly from the AntiVir Guard Control Program. This is for 
example to scan complete drive c: immediately for viruses and unwanted programs.

Start Internet Update

The internet updater can now also be started via this menu option. This improves user-friendliness, 
as you no longer have to load the main program whenever you want to start the updater. This menu 
option is only selectable provided the internet updater is already installed and activated.

Minimize Control Program or Alt+F4 or button 

Click this Item if you would like to exit the Control Program but don't want to close it.

Close Control Program 

To completely exit and close the Control Program you have to click this item. Please note that this 
will not stop the AntiVir Guard Service so that AntiVir Guard will search for viruses and unwanted 
programs anyway.



The Help Menu
Here you can find some more information to operate you AntiVir Guard.

Help (F1) or button  

This will show you this help system. 

Using Context Sensitive Help

This shows you how to use the context sensitive help system

Help Index

This displays links to all available pages in this help file

About AntiVir Guard

Displays some information concerning the AntiVir Guard control program.



The Options Menu
This menu contains the following entries:

Configuration or button 

Select this menu option to open the window Configuration AntiVir Guard, in which you can edit the 
settings for AntiVir Guard.

Show Logfile or button 

Shows the logfile of the AntiVir Guard.



Trouble Shooting
If AntiVir Guard does not work properly or if you have any problems with AntiVir Guard or if you have an 
detection which you are not able to manage yourself, please check the following:

Please check if the AntiVir Service is active!
The small red umbrella in the system tray must be opened. Please activate the service if necessary: at 
the right bottom: Select the "Start" button, and then "Settings | Control Panel" and activate the applet 
"Services" with a double-click (under Windows 2000 and Windows XP you will find the service applet in 
the subfolder "Administrative Tools"). Now look for the entry "AntiVir Service". The startup type must be 
"automatic", status must be "Started". If needed, please start the service manually by selecting the 
appropriate line and clicking the "Start" button. If an error occurs, please check the event log. If you are 
not successful you probably should remove your AntiVir package completely by using "Start | Setting | 
Control Panel | Software". Please restart your workstation afterwards and re-install the software.

The option Local Drives in the group Drives to monitor must be checked.
Check the settings of the group Files to scan. If Use file extension list is selected, you should 

have a look into the file extension list. Please set it to default values if needed. 
To be able to repair a file, it is important that the option Repair is enabled.
Check if AntiVir Guard has scanned the file. 

This can be done by enabling the enhanced logging mode (Complete information) in the logfile property 
tab, accessing the file and checking the logfile afterwards.

If your logfile contains lot of entries like "access denied", you should check the following: The 
AntiVir Guard Service "AntiVirService" needs desktop access rights to be able to display its warning 
dialog boxes. This means that it must log on as Local System Account ("SYSTEM"). Additionally, it needs 
the option "Allow service to interact with desktop" enabled in the Services applet of the Control Panel. 
Please note that the SYSTEM account needs unlimited access to all local drives. The AntiVir Guard 
Service "AntiVirService" must not be installed to other accounts!

More information can be found in the file README in the program directory of AntiVir or in the internet at 
http://www.free-av.com.

AntiVir Support Forum
In order to facilitate your inquiries to the technical support, we have created the AntiVir Support Forum for 
you.

You find the AntiVir Support Forum on the internet at: http://www.free-av.de/forum.

You will find the frequently asked questions about AntiVir PersonalEdition Classic and you will have the 
possibility to submit technical questions to all other forum members and our moderators. Additionally, you 
can discuss with other users of AntiVir and share your own experiences and hints.

To enable us to help you efficiently, please add the following information to your request:

- Version information of the virus definition file (VDF), search engine and program.
- The version information of your operating system and the possibly installed service packs.
- Installed software packages, e.g. antivirus applications from other vendors.
- The exact (!) messages displayed by the application or shown in the logfile.

Technical inquiries via Phone/Fax/Letter and e-mail can not be answered!



Unwanted Programs
Dialer (DIALER)
Games (GAMES)
Jokes (JOKES)
Security Privacy Risk (SPR)
Backdoor Clients (BDC)
Unusual Runtime Compression Tools (PCK)
Double Extension Files (HEUR-DBLEXT)

Dialer (DIALER)
Certain services available in the internet have to be paid for. They are invoiced in Germany via 
dialers with 0190/0900 numbers (or via 09x0 numbers in Austria and Switzerland; in Germany, the 
number is set to change to 09x0 in the medium term). Once installed on the computer, these 
programs guarantee a connection via a suitable premium rate number whose scale of charges can 
vary widely.

The marketing of online content via your telephone bill is legal and can be of advantage to the user. 
Genuine dialers leave no room for doubt that they are used deliberately and intentionally by the user.
They are only installed on the user’s computer subject to the user’s consent, which must be given 
via a completely unambiguous and clearly visible labeling or request. The dial-up process of genuine
dialers is clearly displayed. Moreover, genuine dialers tell you the incurred costs exactly and 
unmistakably.

Unfortunately there are also dialers which install themselves on computers unnoticed, by dubious 
means or even with deceptive intent. For example they replace the internet user’s default data 
communication link to the ISP (Internet Service Provider) and dial a cost-incurring and often 
horrendously expensive 0190/0900 number every time a connection is made. The affected user will 
probably not notice until his next phone bill that an unwanted 0190/0900 dialer program on his 
computer has dialed a premium rate number with every connection, resulting in dramatically 
increased costs.

To protect yourself generally from unwanted 0190/0900 dialers, we recommend that you ask your 
telephone provider directly to deny access to these numbers.

AntiVir recognizes the cost generating dial-up programs known to him by default. If you have 
activated the option "Dialer (DIALER)" under "Unwanted programs" in the configuration menu of 
AntiVir, you will receive a warning whenever AntiVir finds something. You now have the option of 
simply deleting the unwanted 0190/0900 dialers. But if this nevertheless is a desired dial-up 
program, you can declare it as an exception file in the main program and this file will consequently 
not be analyzed any longer. In the AntiVir Guard you have the possibility to disable the dialer 
recognition in the configuration dialogue under Unwanted programs.

Games (GAMES)
There is a place for computer games - but it is not necessarily at work (except perhaps in the lunch 
hour). Nevertheless, with the wealth of games downloadable from the internet, a fair bit of mine 
sweeping and Patience playing goes on among company employees and civil servants. Email 
games are also becoming increasingly widespread, with numerous variants in circulation from simple
chess games to "Fleet Maneuvers" (including torpedo battles). The relevant moves are sent via mail 
programs to partners who then answer them in turn.

Studies have shown that the number of working hours devoted to computer games has long reached



economically significant proportions. It is therefore not surprising that more and more companies are 
considering ways of banning computer games from workplace computers.

Through its extended scanning and identification routines, AntiVir is capable of detecting games and 
eliminating them as unwanted programs. If you have activated the option "Games (GAMES)" under 
Unwanted programs in the configuration menu, you will receive an appropriate warning whenever 
AntiVir reports a find. All you have to do now is press delete - and the game is up in the truest sense 
of the word!

Jokes (JOKES)
Jokes are merely intended to give someone a fright or provide general amusement without causing 
harm or reproducing. When a joke program is loaded, the computer will usually start at some point to
play a tune or display something unusual on the screen. Examples of jokes are the washing machine
in the disk drive (DRAIN.COM) or the screen eater (BUGSRES.COM).
But beware! All symptoms of joke programs may also originate from a virus or Trojan. At the very 
least the user, will get quite a shock or be thrown into such a panic he may do real damage.

Through its extended scanning and identification routines, AntiVir is capable of detecting jokes and 
eliminating them as unwanted programs. If you activate the option "Jokes (JOKES)" with a tick under
Unwanted programs in the configuration menu, you will be notified accordingly of any findings.

Security Privacy Risk (SPR)
Software that maybe is able to compromise the security of your system, initiate unwanted program 
activities, damage your privacy or spy out your user behaviour and might therefore be unwanted.

AntiVir is able to detect "Security Privacy Risk" Software. If you have activated the option "Security 
Privacy Risk (SPR)" under Unwanted programs in the configuration menu, you will receive a 
corresponding warning whenever AntiVir reports a find.

Backdoor Clients (BDC)
In order to steal data or manipulate computers, a backdoor server program is smuggled in 
unbeknown to the user. This program can be controlled by a third party using backdoor control 
software (client) via the internet or a network.

AntiVir is able to detect "Backdoor control programs". If you have activated the option "Backdoor 
Client (BDC)" under Unwanted programs, in the configuration menu, you will receive a 
corresponding warning whenever AntiVir reports a find.

Unusual Runtime Compression Tools (PCK)
Files that have been compressed with an unusual runtime compression tool and that can therefore 
be classified as possibly suspicious.

AntiVir is able to detect "Unusual Runtime Compression Tools". If you have activated the option 
"Unusual Runtime Compression Tools (PCK)" under Unwanted programs in the configuration menu, 
you will receive a corresponding warning whenever AntiVir reports a find.

Double Extension Files (HEUR-DBLEXT)
Executable files that hide their real file extension behind a false one and that can therefore be 
classified as possibly suspicious.

AntiVir is able to detect "Double Extension Files" Software. If you have activated the option "Double 
Extension Files (HEUR-DBLEXT)" under Unwanted programs in the configuration menu, you will 



receive a corresponding warning whenever AntiVir reports a find.



Virus Infection
This provides a brief introduction to the steps to take if AntiVir Guard finds a virus, for example. Please 
note that there are some limits to the functionality of the AntiVir PersonalEdition Classic. Should you 
require antivirus software for other platforms or an extended range of functions, we would recommend the
version AntiVir ProfessionalEdition.

If AntiVir Guard detected a virus ...

1. Don't panic and beware calm!
AntiVir Guard has done all the important jobs automatically if it is configured correctly. If you tried to 
access or to start an infected file, it will be disinfected or moved or the access to this file will be 
denied. After a successful disinfection, you can work with that file as usual. If a disinfection is not 
possible, the file will be normally moved to the quarantine directory and you'll get a warning.

2. Follow the antivirus instructions step by step, don't rush the things!
Now, it is important to check your complete workstation and all possibly infected floppy disks for 
viruses. It would be a good choice to let AntiVir do this job since it has already been installed on your
system. Please try to disinfect all infected files and boot records on your hard disk and all floppy 
disks. Ask your dealer or call the H+BEDV Datentechnik GmbH if you need any assistance. Possibly 
it would be a good idea to activate the automatic repair option inside AntiVir Guard. If AntiVir or 
AntiVir Guard is not able to disinfect the file, please send us a copy for further analysis. We will 
provide you with a solution as fast as possible. At least, try to investigate where the virus did come 
from. Check your anti-virus strategy if needed to beware of further infections.

3. Inform your colleagues, your boss and your business partners!
It is not a very pleasant job, however information is very important in such cases. Especially, if the 
virus has been imported from outside your site. Please inform your colleagues, your boss or your 
security manager about the infection!

4. New, unknown viruses and suspicious files
Please send new viruses and suspicious files as an encrypted archive file attached to an email to 
virus@free-av.com. Please don't for get to mention the password and a few comments about the 
attached file in your mail.



Windows® XP Security Center
- From Windows® XP Service Pack 2 on -

In General
The Windows Security Center checks the status of a computer with emphasis on three important security 
aspects.

Firewall
Automatic Updates
Virus Protection

If there is a problem with one of those important points (for example: an older antivirus program), the 
security center will send out a warning and will recommend a solution as to how you can protect your 
computer in a better way.

The security center and AntiVir PersonalEdition Classic
You can receive following notices from windows security center with regards to your virus protection.

Virus protection NOT FOUND
Virus protection OUT OF DATE
Virus protection ON
Virus protection OFF
Virus protection NOT MONITORED

Virus protection NOT FOUND
This notice of Windows security center will show when it has not found any antivirus software on your 
computer.

Note:
Install AntiVir PersonalEdition Classic on your computer to protect it from viruses and unwanted 
programs.

Virus protection OUT OF DATE
If you have had already installed Windows XP Service Pack 2 and then install the AntiVir PersonalEdition 
Classic the first time ontop of that, or you install Windows XP Service Pack 2 onto a system on which 
already AntiVir PersonalEdition Classic exists, then you will see following message:



Note:
In order for windows security center to recognize the AntiVir PersonalEdition Classic as up-to-date it is 
definitely necessary to perform an update. You update your system performing an AntiVir Internet Update.

Virus protection ON
After installing the AntiVir PersonalEdition Classic and following with an update you will receive following 
message:

Now AntiVir PersonalEdition Classic is up-to-date and the AntiVir Guard is activated.

Virus protection OFF
Following message will appear when you de-activate AntiVir Guard or when you turn off the AntiVir 
Service. 

Note: 

To activate the AntiVir Guard, start the AntiVir Guard control program. In the menu: "File | Activate
AntiVir Guard" should be checked. You will also be able to see whether the AntiVir Guard is activated 
when the red umbrella in your task-menu is opened up.

If need be to activate the AntiVir Service, do as follows: Select the "Start" button, and then 
"Settings | Control Panel" and activate the applet "Services" with a double-click (under Windows 2000 and
Windows XP you will find the service applet in the subfolder "Administrative Tools"). Now look for the entry
"AntiVir Service". The startup type must be "automatic", status must be "Started". If needed, please start 
the service manually by selecting the appropriate line and clicking the "Start" button. If an error occurs, 
please check the event log.

Virus protection NOT MONITORED
If you receive following message from the windows security center, then you have chosen to monitor your 
antivirus software yourself.



Note:
Windows Security Center is supported by the AntiVir PersonalEdition Classic. At any time though, you will
be able to activate this option by choosing "Recommendations..." in the menu.

Note:
Even though you have installed Windows XP Service Pack 2 you will need an additional virus protection 
solution as for example, the AntiVir PersonalEdition Classic. Although Windows XP Service Pack 2 
monitors your antivirus software, it does not contain any antivirus functions. Therefore you would NOT be 
protected from any viruses or other Malware, unless you have an additional virus protection solution.




